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1. 

2 

3 

4. 

5. 

7. 

8. 

9 

10. 

B 

In which of the following is a artificial lake? 
(A 
(C) Gobind Sagar lake 

Dal lake 

(A) Nagpur session 
(C) Bombay sesion 

In which session of Indian National Congress decided to observe 26th January of every year 

as the Independence day? 

(A) Awadh 

(C) Arrah 

(C) 
(A) Sree Narayana Guru 

Vaghbhatananda 

Wajid Ali Shah, the ruler of which one of the follow ing states was removed from power by 

British in the name of misrule at the time of 1857 Revolt? 

The best FIFA Men's Player of 2022: 
(A) Christiano Ronaldo 

Maximum: 100 markS 

Who wrote the famous book Prachina Malayalam'? 

(A) Rudra Prayag 

Mannath Padmanabhan organised Savarna Jatha in support of : 

(A) Guruvayur Satyagraha 

(C) Vishnu Prayag 

(A) 
(C) 

Who won the 52nd Odakuzzal award? 

Ambikasuthan Mangad 
Sethu 

(B) 
(D) 

(C) 

FB) 
(D) 

Aravind Panagariya 

(A) Kottiyoor temple 
Thirunelli temple 

(B) 
(D) 
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(B) Barout 

(B) 
(D) 

The town located on the confluence of river Bhagirathi and Alakananda is : 

(B) 

Who is the present Vice Chairman of NITI Aayog? 
(A) Suman Bery 

Time:1 hour and 30 minutes 

Wular lake 
Sambhar lake 

(B) 

Lahore session 

(D) 

Amaravathi session 

Neymer 
(D) Lionel Messi 

(B) 

Paliyam Satyagraha 
Vaikkom Satyagraha 

(B) Dasa Prayag 
(D) Karna Prayag 

(B) 
(D) 

Chattambi Swamikal 
Swami Dayanand Saraswati 

The famous Hindu temple situated in the valley of Brahmagiri hill : 

Sara Joseph 

Rajiv Kumar 
(D) B.V.R. Subrahmanyan 

Mudnakudu Chinnaswamy 

Palani temple 
None of these 

[P.T.O] 

(C) Harry Kane 

(C) Salt Satyagraha 

(D) Delhi 



11. What is the name of a device that converts digital signals to analogue signals? 

12. DPI means : 

16. 

(A) Router 

17. 

(C) Modem 

18. 

19. 

(A) Dots Processing Inch 
(C) Diagram Per Inch 

14. The Third-generation computers are based on: 

20. 

13. Every computer connected to the internet is identified by a unique four-part string, 
known as: 

(A) IP address 

(C) 

(A) 
(C) VLSI microprocessor 

(A) 

(C) 

(A) 

(C) 

Domain name 

(A) 

Transistor 

15. Malware is the short form for malicious software and used to refer to : 

Spyware 
Virus 

Web browsers 

Web portals 

is an example of search engine. 

(C) Bing 
Yippy 

Touch Screen is 

(C) 

(A) Input 
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(C) Memory 

Norton is an example of -
(A) Browser 

(C) Search Engine 

(A) Dennis Ritchie 

(B) Switch 
(D) Repeater 

Charles Babbage 

(B) 

Software. 

(D) 

is the special kind of website which offers so many services to its users. 
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(B) 

(D) 

B) 
(D) 

B) 

(D) 

(B) 
(D) 

(B) 

Type peripheral Devices. 

Dots Per Inch 
None of these 

(B) 
(D) 

Host name 

B) 

None of the above 

Integrated circuit 
ULSI microprocessor 

Worm 

All of the above 

(D) All of these 

Web servers 
None of these 

DuckDuckGo 

Who is the following is known as the father of computers? 

Output 
Both Input and Output 

Anti-Virus 

(D) None of these 

(B) John Napier 
(D) None of these 

B 



21. 

22. 

23. 

26. 

27. 

28. 

What do we call a collection of two or more computers that are located within a limited 
distance of each other and that are connected to each other directly or indirectly? 

29. 

(A 

B 

(C) Local Area Network 

Internet 

(A) What You See Is What You Get 

(B) What You Seek Is What You Give 

(C) What You See Is What You Give 

25. To Select all the text in MS Word document by: 

What is meant by the concept of WYSIWYG in MS Word? 

(A) Save 

(C) Redo 

Which commands are present in Quick Access Toolbar in MS Word? 

(A) Landscape 
24. Which of the following is an example of page orientation in word document? 

(A) Ctrl + S 

(C) Ctrl + A 

The name of a word document displays in: 

(A) 

(C) 

Ribbon 

Status bar 

(C) Ctrl + H 

(B) 

(A) Ctrl + V 

(D) 

(C) Ctrl + S 

(A) Mail merge 

(B) 

(C) Both (A) and (B) 

D) 
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(B) 

What is the shortcut key for "Paste" in MS Word? 

(D) 

(B) 

(D) 

(B) 

(D) 

(B) 

What is the shortcut key for "Find and Replace" dialog box in MS Word? 

(A) Ctrl + F 

(D) 

Intranet 

(B) 

Wide Area Network 

D 

(B) 

Undo 

(D) 

All of the above 

Subscript 
None of these 

Ctrl + 1 

Ctrl + V 

Title bar 

Home tab 

In MS Word, which enables us to send the same letter to different persons? 

Ctrl + R 

Ctrl+ Shift + F 

Ctrl + P 

Ctrl + E 

Macros 

None of the above 
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(D) None of the above 

(C) Superscript 



30. 

31. 

33. 

34. 

35. 

36. 

37. 

What is the default file name of Microsoft Excel file? 

(A) 

39. 

32. Which programming language is used to write a Macro in MS Excel? 
(A) C 

(C) Java 

(C) 

In MS Excel the intersection of a column and a row in a worksheet is called : 
(A) Box 

(C) Range 

Workbook.xlsx 

Worksheet.xlsx 

(A) 
(C) 

Power (number, Power) 

(A) ROUND () 

When a range is selected, hov can you activate the previous cell? 
(A) Press the Alt key Press Tab 

Press Enter 

= Power (number, Power) 

Which Chart can be created in Excel? 

(A) 

In MS Excel what is the syntax for powver function? 

(A) Doughnut 

(C) 

Excel displays the current cell address in the 

(B) 

Formula bar 
Name Box 
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(D) 

(A) Landscape 

What is a Microsoft PowerPoint? 

(B) 

(A) Spreadsheet Program 
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(D) Page Break 

In which function return the remainder after a number is divided by a divisor in EXCEL? 

(B) C++ 

(B) 

(D) Visual Basic 

(D) 

(B) 
(D) 

Workbook l.xlsx 

(B) 

Worksheet 1.xlsx 

(D) 

B 

Cell 

D 

(B) 

(D) 

(B) 
(D) 

Press Ctrl + G 

(power, number) 
= Power (Power, number) 

38. Which of these is the page setup orientation by default of the slides in PowerPoint? 

Power 

FACT () 
DIV ) 

(B) 
(D) Title Bar 

Line 
All of the above 

Status Bar 

Portrait 

None of the above 

Presentation Program 
All of the above 

B 

(C) MOD () 

(C) Pie 

(C) Vertical 

(C) Database Program 



40. Which of the following is called as page to create a presentation in PowerPoint? 

41. 

42 
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(A) 
(C) 

18. 

Which of the following shortcut key is used to start the slideshow? 

(A) Using F5 key 
(C) Using Fi key 

Sheet 
Document 

44. Which is the menu to create a text box on a shde? 

B 

(A) F1 
(C) F3 

(A) 
(C) 

Which of the following shortcut key is used to stop the slide show? 

(A) Esc key 
(C) Ctrl + N 

45. PowerPoint presentation is a collection of : 

(A) 
(C) 

View -> Text Box 
Insert -> Text Box 

Which of the following shortcut key is used for help in PowerPoint? 

Slides and Handouts 

Outlines 

((A) Central Processing Unit 

47. Which of the following is an output device? 

(C) Arithmetic and Logic unit 

(A) Keyboard 
(C) Light pen 

(A) 
How many bytes does 2 kilobytes represent? 

46. Which of the following is the brain of the computer? 

512 

2048 

49. Full form of URL is 

((A) Uniform Resource ILocator 

(C) Uniform Registered Link 

50. Which operating system is developed by Apple? 

(B) Slide 

(A) Linus 

(C) 

(B) 

Mac OS 

(D) 

7 

(B) 
(D) 

(B) 

B) F2 

(D) 

(D) F4 

(B) 
(D) 

B 
(D) 

(B 

Using F3 key 
Using F6 key 

Ctrl +0 

(D) 

Ctrl + K 

(B) 
(D) 

(B) 
(D) 

Tools -> Text Box 
Format -> Text Box 

(D) Printer 

Speaker's notes 
All of the above 

(B) 1024 

Memory 
Control unit 

Mouse 

256 

Uniform Resource Link 

None of these 

Window 
DOS 
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(D) None of the above 



51. Type guide is fitted 

52. 

53. 

54. 

(ii) 
(iiü) at the middle of the segment 
Which statement is false in this statement? 

(a) 
(b) 

(c) 

Items required for cleaning a typewriter: 
Long brush, Polishing cloth 

(d) 

at the bottom of the segment 

at the top of the segment 

(i) 
(ii) 

(A) Only (iiü) 
(C) Only (i) 

Which of the following is true in this? 

(iii) 

Oil can, hat pin 

(ii) (b) and (c) 

(1) 

Petrol, Soft rag 

(iii) (c) and (d) 
(iv) 

Screw driver, Cleaning paste 

(iv) 

(a) and (b) 

(d) and (a) 
(AY 

(C) only (iii) and (iv) 

Pinion wheel, Segment slots 
(iv) L0Ose dog, Platen 

only (i) and (ii) 

Rocher Mechanism includes the functioning of the following parts: 
Pinion wheel, Escapement wheel 
Escapement wheel, loose dog 

(A) Only (i) and (ii) 

(C) Only (iii) and (iv) 

(B) 

(D 

(B) 
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(D) 

From the below given statements, which options are true : 

(i) When the machine is at rest, the loose dog is in action 

Only (iü), (iii) and (iv) 

(B) 

Only (iv), (i) and (ii) 
All of the above 

Only (ii) 

only (ii) and (ii) 

(D) only (iv) and (i) 

8 

None of the above 

(B) 
(D) 

When the pressure on the rigid dog leaves the tooth and the loose dog catches the next 
tooth of the escapement wheel 

(ii) When the character key is pressed, rigid dog is in action. 
Carriage moves by one degree when loose dog leaves the tooth of the escapement wheel 

(A) Only (i), (ii) and (iii) 

Only (ii) and (iii) 
Only (iv) and (i) 

B 



55. 

58. 

The ribbon starts to move from one spool to anot.her spool automatically is known as : 

59. 

(A) Reverse movement 

60. 

(B) Automatic movement 

(C) 

56. The expanded form of EFTS: 

(D) All of the above 

Automatic Reverse movement 

(A) European Free Trade System 

(B) Electronic Free Treasury System 

(C) 

57. When the variable line spacer is used, the contact between the cylinder ratchet and the 

cylinder is ceased. 

(D) Electronic Fund Transfer System 

European Federal Temporary System 

The above statement shows that Variable line spacer is 

C) 

(A) used to cease the cylinder 

(D) 

Both (A) and (B) are correct 

Both (A) and (B) are false 

The figure 370 is written in Roman Numerals as: 

(A) CDXX 

(C) CCCLXX 

Malayalam Typewriter was introduced by: 

(A) K.N. Panicker 

(C) R. Arulappan 

Rhythmic touch method is also known as 

(A) Sight method 

(C) Legato method 

9 

(B) LLLDXX 

(D) CCXLL 

(B) 

D) N.S. Pandala 

(B 

Kerala Government 

(D) 

Staccoto method 

All of tlhe above 
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(B) used to rotate the cylinder 



Pick 

out 

th
e
 

sentence 

w
hich 

18 

gram
m

atically 

correct 
: 61. B

etw
een 

you 

and 

me, 

everything 
is 
a m

ystery 

B
etw

een 

you 

and 
I, everything 
is a m

ystery 

B
etw

eenI 

and 

you 

everyth1ng 
1s a m

ystery 

B
etw

een 

you 

and 

he, 

everything 
is 
a m

ystery 

(A
) (B) (C

) (D
) 

W
hat 

w
ent 

wrong! 

Fill 
in

 
the 

blank 

w
ith 

an 

apt 

phrasal 

verb 
: 

Looking 

past 
in life, 
I still 

can't 

62 

B) Figure 
out 

(A
) 

D
rag 

out 

(D
) 

D
rop 

out 

(C) 
Stand 
out 

w
ith 

all 

due 

respect, 

before 

th
e 

body 

was 

crem
ated. 

Choose 

the 

correct 

spelling 

They 

perform
ed 

the 

last 

63. 

rites 

(B
) 

(1) 
rights 

wrights 

(D
) 

W
Iites 

(C) 

64. 

ldentify 

th
e 

sentence 
H

e 
has 

(A
) They 

had 

finished 

only 

half 
the 

work 

(B
) Let 

him
 

be 

invited 
to

 
the 

party 

(C
) I shall 

inform
 

them
 

of this 

(D
) 

C
hoose 

the 

appropriate 

question 

ta
g

: 

He 

chose 
a book, 

65. 

Isn't 
he? 

(B
) (D

) 

Did 
he? W

on't 
he? 

(A
) Didn't 
he? 

C) 

your 

car 

from
 

th
e 

w
ay? 

W
ould 

you 
m

ind 

66. 

m
O

veS 

(B) 

M
ove 

A) 

m
oving 

(D
) 

m
oved 

(C) 

In 
the 

follow
ing 

sentence, 

supply 
a verb 
in 

agreem
ent 

w
ith 

its 

subject 
: 67. responsible. 

Either 
the 

casts 
or the 

director 

W
ele 

(B) 

W
as 

A) 

a
m

 

(D) 

aT
e 

(C) 

B
 l0
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w
hich 

is 
in 

the 

passive 

voice 
: 

reserved 

his 

seat 
on 

th
e 

bus 



68. Mr. Bean saw a 

71. 

69. You must get some more questions, 

(A) flock 

73. 

(C) bunch 

74. 

70. IfI had known that you were coming, : 

B 

(A) 

(C) however 

(A) 

(C) 
(D) 

whereas 

B) 

I would have prepared your favourite dishes 
(B) Iwould receive you at the railway station 

(CY 

(A) ifI needed lunch 

I would ask you to bring some sweets 

of keys lying on the floor. 

72. By the time we reached home, the thief 

Fill in the blank with the correct reported speech : 

She asked me 

do you come with me 

Ramesh is 

does she visit this place often 

(D) do you like pizza? 

(A) leave 

I will take you to some important destination 

(C) leaves 

Fill in the blank using an article : 

(A) a 

(C) the 

(A) a few 

His explanation was so complicated that only 
in the interactive session. 

(C) the little 

(B) 

-MBA graduate. 

(D) bundle 

11 

You can't complete your project. 
(B) 

(D) moreover 

group 

(B) 

otherwise 

the spot. 

B) 

(D) had left 

(B) 

left 

an 

(D) of 

students responded to his queries 

little 

(D) a little 

108/2024-M 
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75. 

P
ut 

th
e 

p
h

rases 
in

 

the 

correct 

order 
to 

unscram
ble 

th
e 

sen
ten

ce: 

the 

m
ost 

interesting 

m
ovies 

/ 1 have 

ever 

seen 

/T
h

is 
is 

one 
of 

(C) 

(b) 

(a
) (a) 

- (b)� 
(c) 

(B
) 

(b) 
� (a) 
- (c) 

(b)-
(c) 
- (a) 

(D
) 

(c) 
- (a)-
(b) 

(A) (C) 

76. 
The 

W
hat 

does 
the 

idiom
 

"a 

left-handed 

com
plim

ent" 

mean? Positive 

(A) Insulting 
rem

ark 

B) 

Approval 

(C) 

Encouragem
ent 

(D
) 

Give 
a one 

w
ord 

substitute 
for 
"a 

sudden 

com
plete 

failure. 

77. 

Holocaust 

(B
) 

(A) 
Debacle (D

) 
N

em
esis 

M
alady 

(C) 
Find 
the 

word 

which 
is a synonym

 

of"Cliche". 

78. 

(B) 
Novelty 

(D
) 

O
riginal 

C
reative 

Stereotype 

(A) 
(C) 

affection 
elsew

here. 

(B) 

N
egligence 

from
 

the 

parents 

causes 

the 

children 
to 

look 

Fill 
in 
the 

blank 

with 
a suitable 

preposition: 

79. 

(D
) 

for 

(C) 
with 

(A
) 

at 

Find 

th
e 

figure 
of speech 
of the 

follow
ing 

sentence 
: 

"M
y 

blood 

turned 

cold 

like 
the 

moon". 

B0. 

(A) 
M

etaphor 
(B

) 
Sim

ile 

Personification 

(C
) (D

)) 
O

xym
oron 

B
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publisher 

told 
me 

that 
my 

m
istakes 

w
ouldn't 

be a 

problem
 

in the 

future. 
I thought 
he was 

very 

kind, 

but 

later, 
I realized 

that 
he 

was 

giving 
me 
a left-handed 

com
pl1m

ent. 

feedback 
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100. 
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hen 
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